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1| LOADING “.VFF” DATA       2010 

 
 

1 Loading “.vff” Data 
1) Locate “.vff” data  

2) Run script to strip header 

a. In terminal, type: 

/mingus/data2/spollman/bin/vffStrip <input.vff> 

<output.raw>

 

b. For an alternative to Step 2a please see: Step 8d 

3) Open VGStudio 

a. In terminal, type:  
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“ vgstudiomax20 

“

 

4) Import “.raw” data 

a. File > Import > Raw Volume 

5) Select file 
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a. Browse > locate 

file

 
6) Specifying data type 

a. Your data will most often be in 

i. Signed 16 bit 

ii. Binary 

iii. Big Endian 
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b. If you are unsure you can click guess to instruct VGStudio to guess the data type 

c. Alternatively you can try to change signed/unsigned or big/little Endian and then check 

your 2d and 3d data set in VGStudio to see how it responds 

7) Size 
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a. Input Cartesian ”X, Y, Z” size values in given 

fields

 
b. If you do not know the size of your volume, in Terminal, type: 

grep -a size 

<input.vff>

 

c. Header size should be 0 because we have already stripped it 
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d. Alternatively you can tell VGStudio to guess the size of your file’s header by pressing 

guess 

8) Load as 

a. Adjust the resolution 

i. In Terminal, type: 

head 

<input.vff>
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ii. Insert given 

spacing

 
9) ROI & Skip Selection 

a. Next 

10) Manipulation 

a. Next 

2 Manipulating Volumetric Data 
 

1) The first step is to get acquainted with the basic tools VG Studio (VGS) has to offer. There are 

two main tools for controlling your volumes. 

a. Rotate 

i. Surrounds the object with a red box. Left clicking and dragging the mouse 

rotates the object along both the horizontal and vertical axes. To control the 

object without having to worry about the extra degrees of freedom being able 

to rotate in every direction provides (which can make manipulation very 

difficult) the keyboard arrows can be used to rotate your volume, so that you 

know you are only moving along one axes at a time. Middle mouse button and 

drag moves the volume along the third axes. 

b. Move 

i. You can switch between move and rotate mode by double clicking the middle 

mouse button. When you do this, you will notice a green box around your 

volume; this means you are in “move” mode. Left clicking and dragging moves 

the object along 2 axes; up and down and side to side. Dragging while holding 
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down the middle mouse button will move the volume back and forth along the 

3rd axis. 

Note: When you are controlling an active object with either of the object manipulation tools, if the 

object is unlocked in the scene tree you will be moving the object itself in 3D space. However, if it is 

locked you will instead be moving the camera, not the object itself. This is important when considering 

your object relative to other volumes in the scene tree, i.e. if you intend to have more than one volume 

visualized at a time. To lock and unlock objects on the scene tree clock the lock icon next to an object’s 

icon in the scene tree. To use these transformation tools with more precision, hold down the alt key 

while  using either command. 

2) Now, get to know the toolboxes 

a. Scene Tree 

i. In the scene tree is where your imported volumes will show up.  The scene tree 

also contains all objects in the current project; this includes the camera. The 

camera object is useful if you want to select it and transform the camera’s 

position, not an individual volume’s. The camera object on the scene tree 

contains two light sources that are off by default but can be activated and 

customized in the light toolbox. The camera and all your volumes/imported 

objects, when unlocked, can have their positions reset to undo all the 

transformations done to them by right clicking an object and selecting reset. 

This is useful when if you have transformed objects in an undesirable way or if  

ii.  

you wish to line up multiple objects. Clipping objects can also be controlled from 

under an object’s directory in the scene tree. Beside each object’s name is a box 

with a check mark in it. This controls an object’s visibility in the 3D window. 

Objects can also be grouped into folders to make a scene with many volumes 

more manageable. Clip tools can also be applied to groups of objects if they are all 

contained in a folder 

b. Volume Rendering 

i. A very important tool. “Preset” selection allows you to apply a predetermined 

grey value opacity configuration, including a simple ramp, or a component view; 

which breaks up the scale of grey values into a continuous rainbow, allowing for 

increased contrast between segments. The opacity manipulation area (OMA) is 

an extremely powerful tool that is integral in visualization in VGS. It is an x-y line 

graph of grey values by opacity over a histogram of voxel count by opacity. To 

help explain it, say you have an object loaded into VGS and you have it selected. 

The OMA displays a regular grey scale histogram of that object it shows a count 

of voxels at each grey value. On top of the histogram is a line graph, where with 

the OMA you can adjust the transparency/opacity of voxels at a specific grey 

value. The graph works on the x-axis by displaying the full range of grey values, 
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and the y-axis goes from 0% opacity (invisible/fully transparent) to 100% opacity 

(completely visible/zero transparency). If you look at the OMA you will see the 

line graph. The default line is a straight line known as a ramp from 0% opacity at 

the default isosurface grey value, to 100% opacity at the maximum grey value. 

Grey values along the line are rendered at the opacity dictated by the line’s y-

value/opacity value at that point. Thus if you had a ramp going from (-1000, 0) 

to (1000, 100) you would have 50% opacity at a grey value of 0. This line can be 

easily adjusted. By default it has two handles, one at each the min and max grey 

values. These default handles can only be adjusted along the y-axis. However, 

by middle clicking anywhere along the line you can create a new handle. By left 

clicking and dragging this handle you can move it along both axes. This would 

allow you to, for example, create a ramp from (0, 0) to (1000, 100), effectively 

leaving all voxels with a grey value under zero not rendered. You would do this 

by dragging a new handle to (0, 0) with the left mouse button. Since you can 

create an infinite number of handles, you can very specifically display only 

voxels of grey values you want to be rendered. You can also create intervals to 

easily separate sections of a volume’s grey values. Create an interval by right 

clicking anywhere in the OMA then selecting new interval. The interval can be 

moved using left click and dragging. By setting an interval at x = 0 one could 

easily set a ramp from (-1000, 0) to (0, 100) and (0, 0 to 1000, 100) (not that 

those numbers in themselves are useful but it shows the power of the tool). You 

can save any manipulations you’ve made in the OMA by pressing the diskette 

next to the presets. This will add that particular configuration to the preset list.  

ii. Appearance 

1. The different tabs control the properties of different light sources, the 

transparency tab is different in that it allows you to adjust the 

transparency of the selected volume separate from the OMA; it does it 

differently than the OMA in that it assigns that transparency to every 

voxel regardless of grey value. The white bar under the active tab 

controls the rendered colour and interval colours of rendered object. 

When there is only one interval you will see an uninterrupted bar, and 

adding intervals will divide the bar up visually the same way it would 

appear in the OMA. The bar is scaled to the grey values that appear in 

the OMA. Double clicking the bar opens a colour selection screen 

affecting the interval you selected. The default rendering colour is 

white.  

iii. Rendering Settings 

1. The software comes with 10 different rendering settings. Each algorithm 

has its strengths and weaknesses; some will suit certain situations 

better than others. The isosurface renderer is the standard/default 

algorithm, and while it gives you a good idea of the surface detail, it is 

not very customizable and does not render interior structure, which is 
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one of the strong points and a good reason to use VGS. Scatter HQ is a 

good, fast rendering setting to have on while adjusting settings, but it is 

best to go through the different algorithms in each situation and see 

which loads fastest, and which looks best. While working on your 

project it is better to use the faster algorithms, and once you get to final 

rendering, you can simply change the setting to the algorithm which you 

think will look best. 

c. Transform 

i. When a volume is unlocked and selected you can manually type in the x-y-z 

coordinates to transform the object’s position and orientation. This can also be 

done more simply using the move and rotate tools, however this method 

provides exact precision, and thus is useful when you are having trouble by the 

faster/easier methods. You will see the quantitative effects of any 

transformations you have applied in this toolbox.  

d. Light 

i. To adjust the parameters of the camera’s light source, select one of the two 

light sources listed in the scene tree under camera, or  create your own specific 

to an object by right clicking on that object in the scene tree and selecting: new 

> then either spot, point, or directional light. This will create a light source that 

illuminates solely the volume it is under in the scene tree. The light sources 

listed under camera however illuminate all objects rendered in the 3D window. 

When you select a light source under the scene tree you can adjust the type of 

light from the default directional to either point, or spot, and you can adjust the 

light’s colour and intensity properties.  Colour using the small white boes next to 

the property boxes (comb, diff, spec) and intensities by changing the values of 

the numbers next to those properties. Shadow mode is a useful feature when 

trying to get a nice looking visualization; it is generally an aesthetic effect. 

Turning shadows on will increase rendering times so it is advise that you only 

activate it once you are done with your manipulation and are ready to capture 

your image (whether it be in an animation or a screenshot). When adding the 

shadow effect you need to activate it in both camera light sources.  As in volume 

rendering you can save your light source to a preset menu. 

e. Clipping 

i. Selecting a clipping object from the scene tree, you can use the clipping tool to 

adjust that clipping object’s properties. Inverting the clipping area is important 

in being able to clip out parts of a volume, and the ability to resize a box with 

precision is also very handy in certain situations.  

f. Camera 

i. Gives you the ability to change the camera’s orientation, position, focal point, 

and up vector with infinite precision. Changing the values of these parameters 

allows you to have total control over your camera’s position and therefore what 

you are seeing in the 3D window. This is very useful when making animations, 
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which will be discussed later. Changing the projection mode allows different 

rendering, e.g. stereoscopic (3D) (stereoscopic rendering is generally just an 

aesthetic thing and can be very tough to get working properly). Changing the 

view angle in degrees does just that, meaning it effectively focuses at a closet 

point resulting in a zoomed in perspective. This is a separate way to change the 

distance from the camera as is used by middle mouse button and drag, which 

moves the camera or object itself, while this method decreases the viewing 

angle.  

g. Surface extraction 

i. Allows for the extraction of a polygonal surface mesh. Other software in the lab 

has this capability as well. 

h. Polygon rendering 

i. Allows you to adjust settings of a polygon object. 

3) Other tools 

a. Clipping objects 

i. Select an object from the scene tree: right click > new > clipping plane, box, or 

aligned box. Each has unique features which should be explored by the 

operator.  All clipping objects are controlled by left click dragging yellow handles 

that appear on the objects in the 3D window. Clipping objects are controlled 

with the same move commands as other objects in the scene tree. Clipping 

planes can be moved and rotate along a simple plane. Clipping boxes can be 

moved and rotated and have their size adjust by moving the yellow handles. 

Aligned clipping boxes are the same but cannot be moved independently of the 

subject it is clipping. Refer to the clipping toolbox to invert the selection. 

b. Calibration tool 

i. Cal button next to the move and clip commands. Can automatically define 

material and background thresholds. Its effectiveness is easily hindered by 

complex volumes with many different materials. By clicking define material by 

example area and following the instructions you can manually calibrate as well. 

To remove calibration on an object, simply click the calibration button again. 

c. 2D windows 

i. Allow you to view the x, y, and z slices anywhere in a volume. You can navigate 

through the volume stack by changing the slice value in the parameter box of 

each 2D window. Many tools are controlled and displayed in the 2D windows, 

with their effects seen in the 3D window. You can control the visual 

configuration of the 4 windows (three 2D and one 3D) by selecting the drop 

down menu on the same toolbar as calibration. 

d. Animation tool 

i. Select the reel of film on the left tool bar or animate on the drop down menu 

then select keyframer mode to ender keyframer mode. This activates camera 

positions in the 2D windows and animation toolbox which is situated under the 

2D/3D windows along the bottom of the screen. 
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e. Region grow 

i. The green and yellow cubic volume icon with a magic wand along the left 

toolbar. Select to activate. Can be useful for segmenting and creating regions of 

interest (ROI). Select a tolerance then click a point or hold and drag out to select 

a region in the 2D window representing the region you would like to segment.  

4) Manipulation techniques 

Once you are familiar with VGS you will be able to follow some of these simple 

protocols. 

After loading up a volume you should have a goal of what you want to achieve with your 

manipulation. What do you want the final volume to look like?  This is necessary when 

deciding what to do to the volume. 

 

a. The first step after loading the volume is to analyze the OMA and then use it to remove 

all the air from the volume. Hopefully your volume will be corrected for Houndsfield 

units, and so air will be around -1000 on the grey value scale. Looking at the OMA, you 

should be able to see this peak on the histogram. First create a new handle along the 

line graph. Next, select the handle and drag it to x=-1000, y=0. If you slowly increase x 

from here you will see most of the air disappear around your scan data. 

b. There may be beds or other extraneous data displayed in the 3D window that are 

remnants of imaging techniques or other laboratory protocols. Through the use of 

clipping boxes, remove them.  

c. Now it is important to select a rendering setting that will help you quickly visualize your 

volume. You will also want to find the setting that you think looks best and will 

eventually use on your final rendering 

d. Looking back at the OMA, now you may want to remove or isolate specific grey value. 

This will be specific to your data set and final goal. To use an example from my own 

work, in one project my goal was to isolate different tissue types, i.e. adipose, lean, and 

skeletal, on a single mouse. To do this, or something similar you will need as many 

volumes of your object in the scene tree as there are layers that you want to have. So 

using the mouse example where I wanted 3 tissue layers and one surface rendering of 

the mouse, I needed four identical volumes which I would manipulate from then on. To 

create these multiple volumes, right click on the volume in the scene tree you want to 

copy and select copy. Then select the scene icon and right click paste as many times as 

necessary, so three times in my case to get a total of 4 volumes. Now I can manipulate 

the same volume in four different ways. This is also a useful method if you have applied 

manipulations to an object and want to apply further effects while keeping a copy of the 

current state. It is useful to rename these volumes to easily differentiate between them. 

Do this by right clicking the volume you want to rename and selecting rename. Next, 

you will want to turn off the visibility of all volume ones except the one you are actively 

working on. Do this by deselecting the visibility box next to each volume in the scene 
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tree. Now select the first volume you wish to manipulate and turn on its visibility. Now 

you can edit this volume’s OMA to suit your project’s goal. Using the mouse project 

example I wanted to segment adipose tissue. A colleague had determined that similar 

mouse had an adipose tissue threshold of around -200 to 0. To get this interval I would 

have created 3 handles in the OMA and dragged them to: 

i. X = -200, y = 0 

ii. X = 0, y = 0 

iii. And anywhere between the two x values (usually around the middle), then 

select a Y value that provides an opacity that will work in your situation. 

The important thing to remember is that it is the fact that VGS can render these settings 

in real time, so while step iii may sound haphazard, each volume is unique and some 

limited trial and error will always be necessary to get the perfect rendering for your 

situation. You could then continue this formula for the rest of your volumes, selecting a 

different interval for each.  You can then display the layers individually or collectively to 

display a wide range of information 

e. The problem with displaying multiple layers/volumes at the same time can be 

differentiating between them easily. To remedy this you must create contrast between 

them. VGS renders everything white by default, with the value depending on your 

opacity in the OMA. The best way to create a discernable image is to set the different 

layers to contrasting colours. For example, continuing to use my mouse project, if I 

wanted to view lean and adipose at the same time I would give those layers contrasting 

colours. Contrasting colours are, for example, blue and orange, purple and yellow, and 

red and green. First, select one of the layers and double click the white bar in the 

rendering settings box that we said determines the colouring of a volume. Select blue in 

the box that pops up, then do the same for adipose and select orange instead. Now if I 

decide to turn on the visibility for both layers/objects they will be easily discernable 

from each other. Using contrast generally won’t create a realistic looking volume. If that 

was your goal, you would be better off rendering the colours as you expect it would look 

naturally. For example in visualizing a calcified artery I copied my volume to give me two 

copies of the same volume. Then I determined on one volume I wanted to just include 

tissue, and on the other just the calcification. To do this I segmented between -200 to 

200 to include tissue and exclude the calcification which would have a much higher grey 

value.  I then coloured it red and assigned a realistic looking dark value to it. I then 

selected my calcification volume and isolated the calcification by cutting out all grey 

values below about 800, leaving everything above that value. I kept the calcification 

white, and when I had both layers activated you would what you would expect might 

look realistic. 

Once you have a rendering you like you are ready to either animate or capture screen shots. 

To capture an image: 
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 Alt > F > N 

To enter keyframer mode and animate select the film icon on the vertically oriented left toolbar 

or, on the top toolbar: 

 Animate > keyframer 

 

 

 

 

 

 

 

3 Animations 
 

Enter keyframer mode as detailed in the last paragraph of the previous section. 

Like the other tools in VGS, keyframer mode is a powerful tool that requires very close control to use 

effectively. The first step is to check to make sure the animation toolbar is activated. To do this: 

 Toolbars > animation 

And make sure it is selected. The animation toolbar has many important functions, including: 

 Skip to first keyframe 

 Last keyframe 

 Last frame 

 Play 

 Next frame 

 Next keyframe 

 Last keyframe 

 Render animation 

 Animation length 

o Specifies length of animation 

 Animation resolution 

o Specify the resolution of the images in the resulting image stack 
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 Velocity curve 

o Adjusts relative camera velocity against relative length 

 FPS  

o Frames per second 

Another thing to notice is that the 2D windows have changed appearance when you ender keyframer 

mode. Camera trajectories are now visible in the 2D windows, along with keyframe handles, camera 

handles, and tangent handles. 

On default, when you enter keyframer mode the software loads a simple circular camera trajectory 

around your volume in the state it last was before keyframer mode. To view this simple animation press 

play on the animation toolbar. You can practice shuffling through frames and keyframes, and to the start 

and end of an animation. Go to the 2D windows and familiarize yourself with the camera trajectories 

and handles and how to manipulate them. Add a handle by middle clicking anywhere along the line of 

the camera trajectory. This creates a new keyframe. A keyframe is just a special frame in the animation 

where you have specified a particular camera position and other variables. The software will then 

calculate the camera’s trajectory and orientation between your keyframes, and that is how the 

animation is created. Try dragging keyframe handles (the little circles) around and seeing  how that 

effects the resulting animation. Try adjusting the camera. Click on a keyframe, and tangent handles will 

appear around the selected handle. Move these and see the effect in the camera trajectory. You can 

select keyframes from both the 2D window and the animation toolbar. Something helpful to note is that 

when selecting a keyframe in the 2D window it is wise to hold down shift, which prevents you from 

accidentally moving the keyframe while you select it. The process of making an animation is ideally as 

mechanical as possible; doing it on the fly will rarely yield a useable result. The most important thing, in 

my opinion, is to record the exact camera positions for each key frame. My method for this is to open a 

text editor, like K-Edit. Title the new project something like: “camtraj_’projectname’.  And then save it in 

the same folder as your VGS project. Now as you create your animation you can record the keyframe 

number, along with the 9 numbers in the camera toolbox that specify the camera’s position. For 

example: 

 1 

 X1, Y1, Z1 

 X2, Y2, Z2 

 X3, Y3, Z3 

 2… Etc. 

If you copy the coordinates exactly as they are seen in the camera toolbar, you should have no problems 

with mixing numbers up. Let’s make a simple animation. 

We have a volume that we have manipulated, and now we want to do a simple x-y half circle around it, 

and then continue the rest of the circle as an x-z half circle back to the starting point. An easy way to do 
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this without having to figure out all the camera positions manually, by transforming the volume using 

move/rotate tools (something you will have to do most of the time, especially with more complicated 

animations) is by using and concatenating the default animation trajectories. To do this, go to the first 

keyframe of the x-y circle. This will be your first keyframe, and you will want to keep all the keyframes 

until you finish the half circle and get to the other opposite (x) end of the volume. This keyframe would 

have a common position with a keyframe in the x-z circle. Now record all of the camera information for 

the 3 or so keyframes that you are going to use from the x-y circle. Now load up the x-z default camera 

spin. Do this under animation > default circle > x-z. Now you will want to find what that common camera 

position was with the x-y circle. You can either do this by looking at the keyframes in the 3D window or 

by looking at the values in the camera toolbox for each keyframe. Now you’ll want to record all the 

keyframes after that which bring you back to the camera origin. Now that you have the animation 

planned out, the next step is to make the video. First, delete all keyframes except your camera starting 

position (your first keyframe, which will be the same as your final keyframe). Delete these keyframes by 

middle clicking on their handles in the 2D window. So now you should have only one keyframe in your 

animation that corresponds to the same coordinates as the 1st keyframe in your camtraj…txt. The next 

step is to make a new keyframe by middle clicking in the 2D window. You can click anywhere in the 

window, however I would suggest clicking closer to your last keyframe than it will actually be once you 

change its coordinates. This is because VGS can have a hard time recalculating the camera trajectory if 

you make the trajectory too long to begin with, so you can end up with some unfortunate looking 

animations.  Now select this new keyframe and type in the coordinates you have copied into your 

camtraj…txt, and you are done with this keyframe. Repeat until you have all your keyframes. Press play 

and try to be sure your animation looks as you want it to look. If it doesn’t flow as expected a common 

problem can be with the tangent handles. Try selecting the tangent handles around the keyframe where 

the animation is flawed. They can easily get crossed and have other things happen to them resulting in 

weird camera trajectories. Another thing to check for mistakes are the coordinates themselves as it is 

rather easy to type them in incorrectly. If the speed is inconsistent with your expectations you can also 

adjust the velocity curve. To create a new handle, middle click anywhere on the velocity curve and then 

left click and drag to adjust relative velocity, the higher the handle/line the faster the velocity, and vice 

versa. Keep in mind that making one part slower than the rest will make the actual time of the other 

segments faster, because you are adjusting relative time; i.e. although you are making it slower it still 

has to conform to the length you specify in the animation time. Now choose the length you want for 

your animation. This can be entered into the length field in the animation toolbox which is 4 seconds by 

default. You don’t want to make your animation too short or else it will be too fast, and you don’t want 

to make it too long for the opposite reason.  
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4 Rendering Animations and Video Editing in iMovie 
1) When rendering animations in VGStudio Max 

a. Before pressing the “render animation” button 

i. Set the size to a resolution that will project nicely in most situations, usually in a 

4:3 aspect ratio, i.e. 1600x1200 

1. Other similar formats are 1440x1080, 1280x960, 800x600 

ii. Choose the length in time you want your animation to be. The default is 4 

seconds and it can be adjusted using the entry field 

iii. Choose the frames per second you want your animation to be. Both  24 or 25 

frames per second are sufficient options and are widely adopted frame rates 

iv. Always remember to select the scene icon in the scene tree, rather than having 

one of your volumes selected 

1. This prevents the coordinate boxes from showing up in the final 

animation 

v. Right click on the 3D window and  

b. Press render animation 

i. Save animation as “.jpeg” rather than “.bmp” 

ii. Set JPEG image quaility to 100 

Following these steps renders the original animation in high fidelity, and takes about 1 hour for a 20 

second long 1600x1200 movie, at 24 fps. However subsequent video editing using Quicktime and iMovie 

can decrease the video quality if you are not careful. Using this software: 

2) Importing your animation into Quicktime Pro and creating a video file.  

a. In Quicktime: 

i. File > Open image sequence 

ii. Select the first image of your sequence rendered by VGStudio 

b. You can now view your image sequence in a video. To save it as seen, 

i. Save> Save as self-contained movie. 

1. This will save it as a .mov file type which is useful for maintaining fidelity 

if you wish to do further editing in iMovie 

ii. Alternatively, if you are content with the movie as seen, and do not wish to 

watermark etc., then: 

1. Export > Export as Mpeg-4 

2. Under options: 

a. Set File format to MP4 

b. Video format H.264 

c. Set data rate to between 5000 kbits and 8000 kbits/sec 
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i. This is the bitrate of the video and directly determines 

the size of your file. When using MP4 5000kb/s is about 

the minimum for high quality encoding. Increasing the 

bit rate will increase the quality 

d. Image size  

i. Set to match the resolution you picked earlier in both 

VGStudio and Quicktime, i.e. 1600x1200 

e. Frame rate 

i. Set to match what you chose earlier again, i.e. 24fps 

f. OK 

g. Save 

h. You are now done and can enjoy your video. 

3) Getting a watermark 

a. Locate watermarks in directory: 

“ darkness/data/dloruss/robarts/working_watermarks ” 

or 

b. Copy watermark logo off of Robarts site 

i. Paste clipboard into image manipulation software (not a graphics painter, i.e. 

Microsoft paint) like freeware GIMP or proprietary software Photoshop 

1. The following instructions will be for GIMP 2 

ii. Resize image to the size you want your watermark to be 

1. Image > Scale image  

iii. Resize canvas to be much larger than image (200%) 

1. Image > Canvas size 

iv. Move image to bottom right corner of canvas 

1. Tools > Transform Tools > Move 

v. Save file as “.png” 

1. File > Save as > Select file type (.png) > Save  

2. Ensure “save colour values from transparent pixels” is checked/enabled 

4) Open iMovie ‘09 

a. Add video file to iMovie 

b. File > New project 

c. Drag video into “New Event”  
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d. Select the entire video (or portion you wish to select) by dragging the cursor from one 

vertical edge to the other. This should place a yellow box around your selection 
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e. Drag the selected video into your new project’s window 
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5) Add a watermark 

a. Drag “.png” watermark onto video in project 

b. Select option “Picture in Picture”  
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i. If Picture in Picture is not an option: 

1. iMovie > Preferences > enable “Show Advanced Tools”  

c. Extend image over the entire length of the video 

i. Drag watermark file to the very left of the video file, and then extend its right 

border to the length of the video  
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ii. Alternatively if you do not wish to have the watermark over the entire video, i.e. 

if you want to have it start after a title screen and disappear during final credits,  

simply place the left border of the file over the location at which you would like 

to start the watermark, and then extend the right border to where you would 

like the watermark to stop 

d. Select “ Crop, Ken Burns, and Rotation” 

i. Click the preferences/options gear in bottom left corner of your watermark 

image sitting on top of your 
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video

 
ii. In the preview window select crop 

iii. Crop the image to the desired size 
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iv. Click done 

v. Move watermark where you would like it to show up during the video by 

clicking and dragging  
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6) Save your video 

a. After you’ve imported your video into iMovie and are ready to save it for use, select 

your video 

i. File > Optimize video > Full size 

b. Share > Export using 

quicktime

 
c. Save as quicktime file (.mov) for record 

i.  Select Quicktime movie format 

ii.  > options > settings 

1. change quality to best, and encoding to best 

iii. > options > size > dimensions 

1. Select the dimensions that best match those you selected earlier in 

VGStudio, i.e. 1600x1200 
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d. And then save as .mp4 for sharing and portable use. Mpeg-4 is much more useful than 

.mov in terms of compatibility and file size, making it the preferred file type for 

embedding in PowerPoint and for presentations. To save as .MP4 format: 

i. Export using Quicktime 

ii. Select MPEG-4 video format 

i. >Options>Video 

1. Set File format to MP4 

2. Video format H.264 

3. Set data rate to between 5000 kbits and 8000 kbits/sec 

a. This is the bitrate of the video and directly determines 

the size of your file. When using MP4 5000kb/s is about 

the minimum for high quality encoding. Increasing the 

bit rate will increase the quality 

4. Image size  

a. Set to match the resolution you picked earlier in both 

VGStudio and Quicktime, i.e. 1600x1200 

5. Frame rate 

a. Set to match what you chose earlier again, i.e. 24fps 

6. OK 

7. Save 
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